Chapter 183

Non-Inferiority Tests for Pairwise Proportion Differences in a Williams Cross-Over Design

Introduction

Senn (2002) defines a cross-over design as one in which each subject receives all treatments and the objective is to study differences among the treatments. The name cross-over comes from the most common case in which there are only two treatments. In this case, each subject crosses over from one treatment to the other. It is assumed that there is a washout period between treatments during which the response returns back to its baseline value. If this does not occur, there is said to be a carry-over effect.

An $a \times k$ cross-over design contains $a$ sequences (treatment orderings) and $k$ time periods (occasions) corresponding to the $k$ treatments. The design includes a washout period between responses to make certain that the effects of the first drug do not carry over to the second. Thus, the groups in this design are defined by the sequence in which the drugs are administered, not by the treatments they receive.

Cross-over designs are employed because, if the no-carryover assumption is met, treatment differences are measured within a subject rather than between subjects—making a more precise measurement. Examples of the situations that might use a cross-over design are the comparison of anti-inflammatory drugs in arthritis and the comparison of hypotensive agents in essential hypertension. In both cases, symptoms are expected to return to their usual baseline level shortly after the treatment is stopped.

The sample size calculations in the procedure are based on the formulas presented in Chow, Shao, Wang, & Lokhnygina (2018).

Advantages of Cross-Over Designs

A comparison of treatments on the same subject is expected to be more precise. The increased precision often translates into a smaller sample size. Also, patient enrollment into the study may be easier because each patient will receive both treatments. Finally, it is often more difficult to obtain a subject than to obtain a measurement.
Disadvantages of Cross-Over Designs

The statistical analysis of a cross-over experiment is more complex than a parallel-group experiment and requires additional assumptions. It may be difficult to separate the treatment effect from the period effect, the carry-over effect of the previous treatment, and the interaction between period and treatment.

The design cannot be used when the treatment (or the measurement of the response) alters the subject permanently. Hence, it should not be used to compare treatments that are intended to provide a cure.

Because subjects must be measured at least twice, it is often more difficult to keep patients enrolled in the study. It is arguably simpler to measure a subject once than to obtain their measurement twice. This is particularly true when the measurement process is painful, uncomfortable, embarrassing, or time consuming.

Technical Details

The $a \times k$ crossover design may be described as follows. Randomly assign the subjects to one of $a$ sequence groups with $n_1$ subjects in sequence one, $n_2$ subjects in sequence two, and so forth up to sequence $a$. In order to achieve design balance, the sample sizes $n_1, n_2, \ldots, n_a$ are assumed to be equal so that $n_1 = n_2 = \cdots = n_a = n = N/a$. Sequence one is given a specific sequence of $k$ treatments, sequence two is given a different sequence of the same $k$ treatments, and so forth up to sequence $a$.

The statistical model employed by this procedure and given in Chow, Shao, Wang, & Lokhnygina (2018) assumes that there are no sequence, period, or cross-over effects. The statistical model that incorporates these effects is complex for binary data.

Williams Cross-Over Design

Williams cross-over designs are constructed from Latin squares as outlined in Chow and Liu (2009). If the number of treatments ($k$) is even, then Williams design results in a $k \times k$ cross-over design (i.e. with $k$ sequences and $k$ treatments/periods). If the number of treatments ($k$) is odd, then Williams design results in a $2k \times k$ cross-over design (i.e. with $2k$ sequences and $k$ treatments/periods). For example, a Williams design with 4 treatments would result in a $4 \times 4$ cross-over design and would have 4 sequences with 4 periods corresponding to the 4 treatments. On the other hand, a Williams design with 3 treatments would result in a $6 \times 3$ cross-over design and would have 6 sequences with 3 periods corresponding to the 3 treatments.

Define $y_{ijl}$ as the binary response from subject $j$ ($j = 1, \ldots, n$) in sequence $i$ ($i = 1, \ldots, a$) given treatment $l$ ($l = 1, \ldots, k$). Assume that the responses $y_{ijl}$ are independent and randomly distributed with $P(y_{ijl} = 1) = p_l$, which implies that there are no sequence, period, or cross-over effects. The observations taken from the same subject may be correlated with one another.

Further define the paired differences between treatments $u$ and $v$ for each subject within each sequence as

$$d_{ij}(u, v) = y_{ija} - y_{ijv}$$

and the overall true difference as

$$\delta = p_u - p_v.$$

The overall difference can be estimated as

$$\hat{\delta} = \frac{1}{an} \sum_{i=1}^{a} \sum_{j=1}^{n} d_{ij}(u, v).$$
The estimated difference is asymptotically normally distributed with variance \( \sigma_d^2 \), which can be estimated as

\[
\hat{\sigma}_d^2 = \frac{1}{a(n-1)} \sum_{i=1}^{a} \sum_{j=1}^{n} (d_{ij}(u,v) - \bar{d}_i(u,v))^2,
\]

where

\[
\bar{d}_i(u,v) = \frac{1}{n} \sum_{j=1}^{n} d_{ij}(u,v).
\]

The standard deviation, then, is

\[
SD = \sigma_d = \sqrt{\hat{\sigma}_d^2}
\]

with estimate

\[
\hat{SD} = \hat{\sigma}_d = \sqrt{\hat{\sigma}_d^2}.
\]

**Non-Inferiority Test Statistics**

**Higher Proportions Better**

When higher proportions are better, the null and alternative hypotheses for a one-sided non-inferiority test are

\[ H_0: P_u - P_v \leq D_0 \text{ vs } H_A: P_u - P_v > D_0 \]

or equivalently

\[ H_0: \delta \leq D_0 \text{ vs } H_A: \delta > D_0 \]

where \( D_0 \) is the lower non-inferiority bound (i.e. the smallest difference \( (P_u - P_v) \) for which treatment \( u \) will still be considered non-inferior to treatment \( v \)). When higher proportions are better, \( D_0 \) should be less than zero.

The power and sample size calculations are based on the test statistic

\[
Z = \frac{\hat{\delta} - D_0}{\hat{\sigma}_d \sqrt{an}}
\]

which is asymptotically distributed as standard normal under the null hypothesis. The null hypothesis is rejected in favor of the alternative at level \( \alpha \) if

\[
\frac{\hat{\delta} - D_0}{\hat{\sigma}_d \sqrt{an}} > Z_{1-\alpha}
\]

where \( Z_{1-\alpha} \) is the upper \( 1 - \alpha \) percentile of the standard normal distribution.
Higher Proportions Worse

When higher proportions are worse, the null and alternative hypotheses for a one-sided non-inferiority test are

\[ H_0: P_u - P_v \geq D_0 \text{ vs } H_A: P_u - P_v < D_0 \]

or equivalently

\[ H_0: \delta \geq D_0 \text{ vs } H_A: \delta < D_0 \]

where \( D_0 \) is the upper non-inferiority bound (i.e. the largest difference \( P_u - P_v \) for which treatment \( u \) will still be considered non-inferior to treatment \( v \)). When higher proportions are worse, \( D_0 \) should be greater than zero.

The power and sample size calculations are based on the test statistic

\[ Z = \frac{\hat{\delta} - D_0}{\sigma_d \sqrt{an}} \]

which is asymptotically distributed as standard normal under the null hypothesis. The null hypothesis is rejected in favor of the alternative at level \( \alpha \) if

\[ \frac{\hat{\delta} - D_0}{\sigma_d \sqrt{an}} < Z_\alpha \]

where \( Z_\alpha \) is the lower \( \alpha \) percentile of the standard normal distribution.

Bonferroni Adjustment for Multiple Tests

In a design with \( k \) treatments, there are \( k(k - 1)/2 \) possible pairwise \((u, v)\) comparison tests. To protect the overall alpha level, the individual test alpha level if often divided by the number of tests performed. This is known as the Bonferroni adjustment for multiple comparisons. When this adjustment is used in hypothesis testing, the individual test alpha value of \( \alpha/(k(k - 1)/2) \) is substituted for \( \alpha \) in the formulas above.

Non-Inferiority Power Calculations

Higher Proportions Better

According to Chow, Shao, Wang, & Lokhnygina (2018) page 90, the power for the one-sided non-inferiority test of \( H_0: \delta \leq D_0 \) versus \( H_A: \delta > D_0 \) is

\[ \Phi\left( \frac{\delta_1 - D_0}{\sigma_d \sqrt{an}} - Z_{1-\alpha} \right) \]

where \( \Phi() \) is the standard normal distribution function, \( \delta_1 \) is the actual value of the minimum difference under the alternative hypothesis, and \( Z_{1-\alpha} \) is the upper \( 1 - \alpha \) percentile of the standard normal distribution. The sample size is determined using a binary search of possible values for \( n \).

Higher Proportions Worse

Derived from Chow, Shao, Wang, & Lokhnygina (2018) page 90, the power for the one-sided non-inferiority test of \( H_0: \delta \geq D_0 \) versus \( H_A: \delta < D_0 \) is

\[ \Phi\left( \frac{D_0 - \delta_1}{\sigma_d \sqrt{an}} + Z_\alpha \right) \]
where \( \Phi() \) is the standard normal distribution function, \( \delta_1 \) is the actual value of the minimum difference under the alternative hypothesis, and \( Z_\alpha \) is the lower \( \alpha \) percentile of the standard normal distribution. The sample size is determined using a binary search of possible values for \( n \).

**Bonferroni Adjustment for Multiple Tests**

In a design with \( k \) treatments, there are \( k(k - 1)/2 \) possible pairwise \((u, v)\) comparison tests. To protect the overall alpha level, the individual test alpha level is often divided by the number of tests performed. This is known as the Bonferroni adjustment for multiple comparisons. When this adjustment is used in power calculations, the individual test alpha value of \( \alpha/(k(k - 1)/2) \) is substituted for \( \alpha \) in the formulas above.

**Procedure Options**

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

**Design Tab**

The Design tab contains most of the parameters and options that you will be concerned with.

**Solve For**

This option specifies the parameter to be calculated from the values of the other parameters. Under most conditions, you would select either **Power** or **Sample Size**.

Select **Sample Size** when you want to determine the sample size needed to achieve a given power and alpha level.

Select **Power** when you want to calculate the power of an experiment that has already been run.

Select **Effect Size (D1)** when you want to calculate the minimum effect size that can be detected for a particular scenario.

**Test**

**Higher Proportions Are**

Use this option to specify the direction of the test.

If Higher Proportions are “Better”, the alternative hypothesis is \( H_1: P_u - P_v > D_0 \).

If Higher Proportions are “Worse”, the alternative hypothesis is \( H_1: P_u - P_v < D_0 \).

**Power and Alpha**

**Power**

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal means when in fact the means are different.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
**Alpha**
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal means when in fact the means are equal.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

**Adjust Alpha for Multiple Tests**
Check this box to adjust the alpha-level for each individual test to maintain the overall experiment-wise error rate of Alpha.

The adjustment is made using the Bonferroni method where the overall Alpha is divided by the number of tests. The total number of tests is equal to k(k-1)/2, where k is the number of treatments.

---

**Sample Size / Treatments**

**k (Number of Treatments)**
This is the number of treatments given to each subject in each sequence.

**Number of Sequences**
If k is even, the number of sequences (a) in Williams design is equal to k, resulting in a k x k cross-over design.
If k is odd, the number of sequences (a) in Williams design is equal to 2k, resulting in a 2k x k cross-over design.

**Number of Tests**
The total number of tests is equal to k(k-1)/2.

**Range**
k ≥ 2.

**n (Sample Size per Sequence)**
This is the sample size of each sequence in the Williams cross-over design. The individual sequence sample sizes are assumed to be equal such that the total sample size is equal to

\[ N = an \]

where a is the number of sequences. If the number of treatments (k) is even, the number of sequences (a) in Williams design is equal to k, resulting in a k x k cross-over design. If k is odd, the number of sequences (a) in Williams design is equal to 2k, resulting in a 2k x k cross-over design.

You can enter a single value such as 50 or a list of values using the syntax 50 100 150 200 250 or 50 to 250 by 50.
Effect Size – Difference

D0 (Non-Inferiority Difference)
Specify the non-inferiority difference.

When higher proportions are “Better”, the non-inferiority difference is the smallest treatment difference (Pu - Pv) for which treatment u will still be considered non-inferior to treatment v.

When higher proportions are “Worse”, the non-inferiority difference is the largest treatment difference (Pu - Pv) for which treatment u will still be considered non-inferior to treatment v.

You can enter a single value such as -0.1 or a series of values such as -0.2 -0.15 -0.1 or -0.2 to -0.1 by 0.05 in the range -1 < D0 < 1, D0 ≠ D1. When higher proportions are “Better”, D0 should be less than 0. When higher proportions are “Worse”, D0 should be greater than 0.

D1 (Minimum Difference|H1)
Enter a value for the minimum treatment difference to detect under the alternative hypothesis, H1. The power calculations assume that this is the actual value of the difference.

D1 = Minimum of (Pu - Pv)|H1 for u, v = 1, ..., k with u ≠ v

You can enter a single value such as 0 or a series of values such as 0 0.05 0.1 or 0 to 0.1 by 0.05 in the range -1 < D1 < 1, D1 ≠ D0. When higher proportions are “Better”, D1 should be greater than D0. When higher proportions are “Worse”, D1 should be less than D0.

Effect Size – Standard Deviation of Paired Differences

Standard Deviation (SD)
Enter a value for the standard deviation of the paired differences, SD.

Estimating SD using Previous Cross-Over Data
The standard deviation may be estimated using cell counts from a previous cross-over study with n subjects per sequence as described on pages 88 and 89 of Chow, Shao, Wang, & Lokhnygina (2018).

Assume that y_ijl is the binary treatment response for the jth subject (j = 1 to n) in the ith sequence (i = 1, ..., a) given the lth treatment (l = 1, ..., k). Note that we assume that there are equal numbers of subjects in each sequence such that n_1 = n_2 = ... = n_a = n.

Define
\[ d_{ij}(u,v) = y_{iju} - y_{ijv} \]
\[ \overline{d}_{i.}(u,v) = (1/n)\sum_j d_{ij}(u,v) \]

The formula for SD is then
\[ SD = \sqrt{\left[ (\sum_i \sum_j (d_{ij}(u,v) - \overline{d}_{i.}(u,v))^2 / (a(n-1)) \right]}. \]
Example 1 – Power Analysis

Suppose you want to consider the power of a balanced Williams cross-over design with 3 groups and a binary endpoint where the test is computed based on the difference for sequence sample sizes between 30 and 100. The actual minimum difference is 0, the non-inferiority difference is -0.2, and the estimated standard deviation of the paired differences is 1.5. The overall significance level is 0.05 with individual test alpha adjusted for 3 tests.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Inferiority Tests for Pairwise Proportion Differences in a Williams Cross-Over Design procedure window by expanding Proportions, then Cross-Over (Williams) Design, then clicking on Non-Inferiority, and then clicking on Non-Inferiority Tests for Pairwise Proportion Differences in a Williams Cross-Over Design. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Higher Proportions Are</td>
<td>Better</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Adjust Alpha for Multiple Tests</td>
<td>Checked</td>
</tr>
<tr>
<td>k (Number of Treatments)</td>
<td>3</td>
</tr>
<tr>
<td>n (Sample Size per Sequence)</td>
<td>30 to 100 by 10</td>
</tr>
<tr>
<td>D0 (Non-Inferiority Difference)</td>
<td>-0.2</td>
</tr>
<tr>
<td>D1 (Minimum Difference</td>
<td>H1)</td>
</tr>
<tr>
<td>Standard Deviation (SD)</td>
<td>1.5</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

**Numeric Results**

<table>
<thead>
<tr>
<th>Sequence Sample Size</th>
<th>Total Sample Size</th>
<th>Non-Infer. Difference</th>
<th>Minimum Difference</th>
<th>Standard Deviation</th>
<th>Overall Alpha*</th>
<th>Individual Test Alpha*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.36723</td>
<td>30</td>
<td>180</td>
<td>-0.200</td>
<td>0.000</td>
<td>1.500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.47510</td>
<td>40</td>
<td>240</td>
<td>-0.200</td>
<td>0.000</td>
<td>1.500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.57196</td>
<td>50</td>
<td>300</td>
<td>-0.200</td>
<td>0.000</td>
<td>1.500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.65608</td>
<td>60</td>
<td>360</td>
<td>-0.200</td>
<td>0.000</td>
<td>1.500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.72724</td>
<td>70</td>
<td>420</td>
<td>-0.200</td>
<td>0.000</td>
<td>1.500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.78615</td>
<td>80</td>
<td>480</td>
<td>-0.200</td>
<td>0.000</td>
<td>1.500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.83406</td>
<td>90</td>
<td>540</td>
<td>-0.200</td>
<td>0.000</td>
<td>1.500</td>
<td>0.050</td>
</tr>
<tr>
<td>0.87243</td>
<td>100</td>
<td>600</td>
<td>-0.200</td>
<td>0.000</td>
<td>1.500</td>
<td>0.050</td>
</tr>
</tbody>
</table>

* Alpha was adjusted for 3 tests using the Bonferroni method. Power was calculated using Individual Test Alpha.

References

Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
n is the sample size in each sequence.
N is the total sample size from all 6 sequences combined. The sample is divided equally among sequences.
D0 is the non-inferiority difference used to specify the hypothesis test.
D1 is the minimum treatment difference to detect at which power is calculated. D1 = Minimum of (P_u - P_v)\,|\,H1
for u, v = 1, ..., k with u ≠ v.
SD is the standard deviation of paired differences. This is estimated from a previous study.
Alpha is the probability of rejecting a true null hypothesis. It should be small.

Summary Statements
For a 6x3 Williams Cross-Over Design, a sample size of 30 in each sequence for a total of 180 achieves 36.723% power to detect a difference of 0.000 using a one-sided non-inferiority test against a bound of -0.200 with an overall significance level of 0.050 and individual test Bonferroni-adjusted significance level of 0.017 when the standard deviation of paired differences is 1.500.

Dropout-Inflated Sample Size

<table>
<thead>
<tr>
<th>Group</th>
<th>Dropout Rate</th>
<th>Sample Size</th>
<th>Dropout-Inflated Enrollment Sample Size</th>
<th>Expected Number of Dropouts</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 - 6</td>
<td>20%</td>
<td>30</td>
<td>38</td>
<td>8</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>180</td>
<td>228</td>
<td>48</td>
</tr>
<tr>
<td>1 - 6</td>
<td>20%</td>
<td>40</td>
<td>50</td>
<td>10</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>240</td>
<td>300</td>
<td>60</td>
</tr>
<tr>
<td>1 - 6</td>
<td>20%</td>
<td>50</td>
<td>63</td>
<td>13</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>300</td>
<td>378</td>
<td>78</td>
</tr>
<tr>
<td>1 - 6</td>
<td>20%</td>
<td>60</td>
<td>75</td>
<td>15</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>360</td>
<td>450</td>
<td>90</td>
</tr>
<tr>
<td>1 - 6</td>
<td>20%</td>
<td>70</td>
<td>88</td>
<td>18</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>420</td>
<td>528</td>
<td>108</td>
</tr>
<tr>
<td>1 - 6</td>
<td>20%</td>
<td>80</td>
<td>100</td>
<td>20</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>480</td>
<td>600</td>
<td>120</td>
</tr>
<tr>
<td>1 - 6</td>
<td>20%</td>
<td>90</td>
<td>113</td>
<td>23</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>540</td>
<td>678</td>
<td>138</td>
</tr>
<tr>
<td>1 - 6</td>
<td>20%</td>
<td>100</td>
<td>125</td>
<td>25</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>600</td>
<td>750</td>
<td>150</td>
</tr>
</tbody>
</table>

Definitions
Group lists the group numbers.
Dropout Rate (DR) is the percentage of subjects (or items) that are expected to be lost at random during the course of the study and for whom no response data will be collected (i.e. will be treated as “missing”).
Ni is the evaluable sample size for each group at which power is computed (as entered by the user). If Ni subjects are evaluated out of the Ni’ subjects that are enrolled in the study, the design will achieve the stated power.
Ni’ is the number of subjects that should be enrolled in each group in order to end up with Ni evaluable subjects, based on the assumed dropout rate. Ni’ is calculated by inflating Ni using the formula Ni’ = Ni / (1 - DR), with Ni’ always rounded up. (See Julious, S.A. (2010) pages 52-53, or Chow, S.C., Shao, J., and Wang, H. (2008) pages 39-40.)
Di is the expected number of dropouts in each group. Di = Ni’ - Ni.
This report shows the values of each of the parameters, one scenario per row. This plot shows the relationship between sample size and power. We see that a sample size of just over 80 per sequence is required to detect a minimum difference of 0 with 80% power when the lower non-inferiority bound is -0.2.
Example 2 – Calculating Sample Size (Validation using Chow, Shao, Wang, & Lokhnygina (2018))

On page 92, Chow, Shao, Wang, & Lokhnygina (2018) presents an example of finding the sample size required in a 6 × 3 Williams cross-over design (k = 3) to detect a difference of 0.2 with 80% power in a superiority test with a margin of 0.05 with a significance level of 0.05 when the standard deviation of paired differences is 0.75. They compute the required sample size to be 27 per sequence. Note that there is no adjustment for multiple testing in this example.

We’ll validate this procedure by computing the sample size for the same magnitude of difference between the actual minimum difference and the non-inferiority difference—-0.15. We’ll set the non-inferiority bound to -0.2 and the actual minimum difference to -0.05 and should achieve the same sample size results.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Non-Inferiority Tests for Pairwise Proportion Differences in a Williams Cross-Over Design procedure window by expanding Proportions, then Cross-Over (Williams) Design, then clicking on Non-Inferiority, and then clicking on Non-Inferiority Tests for Pairwise Proportion Differences in a Williams Cross-Over Design. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Higher Proportions Are</td>
<td>Better</td>
</tr>
<tr>
<td>Power</td>
<td>0.80</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Adjust Alpha for Multiple Tests</td>
<td>Unchecked</td>
</tr>
<tr>
<td>k (Number of Treatments)</td>
<td>3</td>
</tr>
<tr>
<td>D0 (Non-Inferiority Difference)</td>
<td>-0.2</td>
</tr>
<tr>
<td>D1 (Minimum Difference</td>
<td>H1)</td>
</tr>
<tr>
<td>Standard Deviation (SD)</td>
<td>0.75</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th></th>
<th>Sequence Sample Size</th>
<th>Total Sample Size</th>
<th>Non-Inf. Difference</th>
<th>Minimum Difference</th>
<th>Standard Deviation</th>
<th>Alpha*</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>n</td>
<td>N</td>
<td>D0</td>
<td>D1</td>
<td>SD</td>
<td></td>
</tr>
<tr>
<td>Power</td>
<td>0.80321</td>
<td>26</td>
<td>-0.200</td>
<td>-0.050</td>
<td>0.750</td>
<td>0.050</td>
</tr>
</tbody>
</table>

* Alpha was not adjusted for multiple tests.

The result from PASS is one less than the result from Chow, Shao, Wang, & Lokhnygina (2018). The slight difference appears to be because the authors miscalculated the result. If you compute the sample size using the formula on the top of page 92, the result is 25.6267 = 26 as calculated by PASS, not 27.